
International Journal of New Developments in Education 
ISSN 2663-8169 Vol. 5, Issue 13: 43-48, DOI: 10.25236/IJNDE.2023.051308 

Published by Francis Academic Press, UK 
-43- 

Application of Project Schedule Management in 
Teaching Field 

Ting Chena,*, Haiyun Wangb 

Xi'an Siyuan University, Xi'an, Shaanxi, 710038, China 
a37790356@qq.com, b906138020@qq.com 
*Corresponding author 

Abstract: In the age of information 2.0, digital penetration shows the characteristics of all-round, 
multi-level and wide fields. In the field of education, although the application of new technology and 
new equipment is more popular, teaching methods are more flexible, teaching means are more diverse, 
and teaching platforms are more intelligent, teachers still face a series of difficulties in improving their 
digital competency, such as inconsistent competency standards, low level of data awareness, single 
ability of data application and practice, and insufficient basic guarantee of school informatization. 
Therefore, this paper proposes a new idea to improve teachers' digital competence with the goal of 
cultivating and establishing teachers' project management thinking. It specifically takes project 
schedule management as a breakthrough, combines it with teachers' daily work, and implements it into 
specific case scenarios. From a small point of view, it hopes to solve some practical problems in the 
application of information technology for teachers. From the large aspect, it is expected to provide 
some reference value for the establishment of the digital competence training system of teachers in the 
future. 
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1. Introduction  

In 2017, the General Office of the Communist Party of China Central Committee and The General 
Office of the State Council issued the Opinions on Deepening the Reform of Education System and 
Mechanism, which clearly proposed that students should pay attention to the cultivation of "key 
capabilities that support lifelong development and adapt to the requirements of The Times". The so-
called "key capabilities" here not only include cognitive ability and cooperation ability, but also cover 
innovation ability and professional ability. [1] The following year, the Ministry of Education in the 
introduction of the "Education informationization 2.0 action plan" emphasized again: the key point of 
education informationization 2.0 is "ability acquisition", to promote the comprehensive popularization 
of digital campus construction, and vigorously improve teachers' information literacy. [2] In September 
of the same year, the Ministry of Education issued the Opinions on the Implementation of the Excellent 
Teacher Training Plan 2.0, which believed that big data, cloud computing and other technologies 
should be used to empower teachers 'teaching decision-making. [3] 

All walks of life in China are entering the "Internet plus" era. The Internet technology represented 
by cloud computing, mobile Internet and big data technology is profoundly affecting people's 
production and life style. [4] The development from digital literacy to digital competency is one of the 
key signs of the transformation from information society to knowledge society. The formation of 
knowledge society and ubiquitous digital technology have changed the way of interpersonal 
communication, the content of work and life, knowledge structure, access to information, behavior 
patterns and habits of thinking, etc., and promoted the continuous development of teachers 'digital 
literacy and competence research, resulting in many models, standards and frameworks. [5] In the 
development of teachers in the 2.0 stage of education informationization, we should pay attention to the 
development of teachers 'professional quality and digital competence, and build a high-quality team of 
teachers in the 2.0 era. [6] 

"Project" is a word we often hear in our study and work. IT can be a project for an IT company to 
develop application software for a client, for students to prepare for the English test of CET-4 and 
CET-6, for a teacher in charge to organize a parents' meeting can be a project, for a decoration 
company to decorate an apartment can be a project, for a company to hold an annual meeting can be a 
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project. Therefore, a project can be considered as a temporary effort to create a unique product, service, 
or output. Project management is the process of using specialized knowledge, tools and methods in 
project activities, so that the project can achieve predetermined goals under the condition of limited 
resources. [7] 

2. Project Management  

2.1. The Importance of Cultivating Project Management Thinking 

Project operation is a process of determining project objectives, making overall planning, division 
of labor and cooperation, monitoring the implementation process and completing acceptance under the 
guidance of systematic thinking. Similarly, the development of teaching activities also needs to set 
clear goals, carry out overall planning, division of labor, implement necessary monitoring and 
evaluation, and finally accept acceptance. It can be seen that teaching activities are not static, but also a 
continuous and dynamic process like projects. [8] 

It can be seen that project management has quite a few application scenarios in the field of teaching. 
Project management mainly regards the project as a specific object, and implements scientific 
management of the specific object through temporary organization. The allocation of management 
resources is mainly configured and utilized from human, material and financial resources, and the main 
purpose is to promote the initial goal of the management object to be realized. [9]As a project manager, 
we should not only master professional knowledge and skills, but also have certain planning, 
organization and coordination abilities, and be able to effectively manage all the work involved in the 
project by using systematic viewpoints, methods and theories under the constraints of limited resources. 
It is of great benefit to help teachers engaged in the field of teaching to establish the management 
thinking of engineering and project, cultivate the basic skills of teachers, work ideas, teaching methods 
and the ability to organize and implement various activities, and thus improve their digital competence. 

2.2. Project Schedule Management and its Basic Process 

The ten knowledge areas of project management are as follows: (1) project integration management, 
(2) project scope management, (3) project time management, (4) project cost management, (5) project 
quality management, (6) project human resource management, (7) project communication management, 
(8) project risk management, (9) project procurement management, and (10) project stakeholder 
management. [10] 

As one of the ten knowledge areas of project management, schedule management is the core of 
which is to define the delivery method and time of products through planning and formulating detailed 
work plans, and control the progress of work in the process of project execution. [11] 

Good project management cannot be separated from the project management software with 
complete functions and friendly interface. Common Project management software includes TAPD 
(Tencent), Worktile (Beijing Yi Cheng Star Technology Co., LTD.), Coding (Shenzhen Kuo Pin 
Network Technology Co., LTD.), PingCode (Beijing Yi Cheng Times Technology Co., LTD.) and 
Project (one of the components of Microsoft Office software). 

Taking "Textbook writing Project" as an example, project software is used to realize project 
schedule management, in order to help teachers gradually establish project management consciousness, 
sort out the basic ideas of project management and master the basic process of project management. 
Guide teachers to use Project software to carry out project management practice and solve practical 
problems in work. The project management process diagram is shown in Figure 1. 

 
Figure 1: Project Management process 
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3. Implementation of Project Schedule Management 

In today's educational informationization background, teaching work in colleges and universities 
needs to follow the development trend of educational technology, and adopt more advanced 
educational means in education and teaching activities as much as possible. [12]Education is different 
from entertainment. It does not feed and fill the audience's existing cognition, but revises and inspires 
them on the basis of their existing cognition. The importance of a good textbook in the whole teaching 
activity is self-evident. It not only transmits knowledge and skills, but also inspires readers to think and 
act, helping them to improve their thinking and cognitive abilities. In order to practice the noble 
mission of "educating people for the Party and talents for the country" and to implement the policy of 
"curriculum thinking and politics" of the Ministry of Education, the course leader organized 5 teachers 
from the Information Teaching and Research Section to compile the textbook Modern Educational 
Technology, which is planned to be completed within 240 working days. 

(1) The plan mainly includes the following contents: 

1) Course research 2) Manuscript writing 3) Making supporting electronic resources 

(2) Software tools to be adopted: 

1) Word processing software Word 2) Table processing software Excel 3) Slide making software 
PowerPoint 4) Picture processing software PhotoShop 5) Graphics drawing software Visio 6) Mind 
mapping software Xmind 7) Project management software Project 

(3) The final deliverables of the plan include: 

1) One textbook 2) textbook supporting electronic courseware 3) textbook supporting electronic 
problem sets 

3.1. Project Manager's Spotlight on Planning 

(1) Set the project information 

Creating a project starts with setting up the project information. Open the Project software, in the 
[Project] menu [Properties] function group, by using the [Project Information] function, you can 
complete the project information setting. Among them, the "scheduling method" determines the way to 
schedule the project plan, and the "project start date" is selected to indicate that the project plan is 
scheduled. Select "Project End Date" to indicate that the project plan is inverted. [Calendar] determines 
the working time and rest time of the project. You can choose from the default [Standard], [night shift], 
[24 hours] three default calendars, and you can also customize the project calendar. In this case, the 
start date is set as: January 18, 2023; Set the calendar to: standard; Everything else is left as default. 

(2) Creating a Work Breakdown Structure (WBS) 

According to the main work content of the project plan to complete the task decomposition, that is: 
create the project work decomposition structure. Because the Project software is only a tool software, it 
can not intelligently customize the work breakdown structure of the project, so the process needs to be 
formulated jointly by the project team members according to the past experience and the current 
requirements. The WBS was entered manually in the Project software according to the predefined work 
breakdown structure. Open the Project software, in the [Gantt chart format] menu [Show/Hide] 
function group, check the [Outline Number] option, you can number the task; At the same time, in the 
"Schedule" function group of the "Task" menu, use the "Upgrade Task" and "Downgrade Task" buttons 
to set the hierarchy of the task. Note: Select the default [Automatic mode] for [Task Mode]. This is 
shown in Figure 2. 

(3) Set up task dependencies 

In terms of a project, the more complex the relationship between processes, the more restricted each 
process is by other processes, and the greater its uncertainty will be. [13]In the project, each seemingly 
independent task is not unrelated, but there are certain contextual dependencies. For example: For task 
7 "Outline determination", it can only be started after completing Task 3 "Book Volume statistics", task 
4 "course outline revision", and task 5 "Course material research". Therefore, for task 7, tasks 3, 4, and 
5 are its antecedent tasks. Since task 5 has the longest duration, task 5 is only set as the antecedent task 
of task 7. Similarly, task 9 "write individually" and task 10 "organize discussion" can start only after 
task 8 "task division" finishes. Therefore, for task 8, task 9 and task 10 are its post-tasks. By setting 
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dependencies between tasks in the Project, each independent task can be integrated into an organic 
whole. Once a task is advanced or delayed, the start time and end time of the dependent task will be 
automatically adjusted, so as to achieve the purpose of effective management of the overall progress of 
the project.  

Open the Project software and fill in the number of the preset task in the preset "preset task" column 
in the workspace to complete the task dependency setting. This is shown in Figure 2. 

(4) Estimate the duration of the task 

In Project, the duration of a task is estimated by taking the working day as the minimum unit. 
Because Project software is only a tool software, it can not estimate the duration of the task 
intelligently, so the process requires the Project team members to use the three-point estimation method, 
analogical estimation, expert judgment or estimation according to the preset workload according to 
previous experience, and then manually input it into the Project software. Note: Time to estimate the 
duration Since the duration of the abstract task is automatically calculated, only the duration of the 
subtask needs to be estimated. After the task duration is set, the Project software will automatically 
generate the [completion time] of the task according to the previous Settings on the project start time, 
Project calendar, task dependencies and other information. This is shown in Figure 2. 

 
Figure 2: Prepare a project plan 

3.2. Plan optimization 

(1) Display the optimization Settings 

After the project plan is prepared, the critical path, project duration and Gantt chart display can be 
optimized according to the actual needs of the project. Among them, the following operations can be 
performed to optimize the display of the Gantt chart. Open the Project software and set the Gantt chart 
style, shape, color and display text in the Gantt chart Format menu in the Gantt Chart Style function 
group. At the same time, when the mouse selects a task, the detailed information of the task can be 
displayed in the Gantt chart area, including the name of the task, the start time, the completion time and 
the construction period. 

(2) Finding the critical Path 
Project schedule management is one of the core goals of modern project management, and the critical 
chain method is proposed by physicist Goldratt, which combines the theory of constraints in the actual 
project. [14] 

To understand what the critical path is, the first thing to understand is the concept of total float time. 
The definition of "total floating time" in the Project Management Body of Knowledge (PMBOK) of the 
United States is: it refers to the maximum time that the task can be delayed without affecting the 
completion time of the project. [15] In simple terms, it means flexible maneuvering time. A "critical 
path" is a path whose total float time is zero or negative. Finding out the critical path, on the one hand, 
can calculate the shortest duration of the project, on the other hand, can identify the key tasks that 
affect the project schedule, which is conducive to the overall control of the project schedule. 

Project will automatically plan out the critical path based on the foundation setup for the project in 
the early stage. Therefore, we just need to learn to find the critical path if we understand its meaning. 
There are many ways to find the critical path, but here are a few: 

Method 1: Open the Project software, in the Gantt Chart Format menu [Bar chart style] function 
group, check [Critical Task], then the critical task in the right Gantt chart area will be displayed as a red 
line.  
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Method 2: Open the Project software, add the preset column [Key] in the workspace, then the 
critical task is displayed as "yes", and the non-critical task is displayed as "no".  
Method 3: In the "View" menu "Data" function group, by using "Highlight" function, select "Key", the 
key tasks in the project will be highlighted with a yellow background.  

Method 4: In the "View" menu "Data" function group, by using the "Grouping by" function, select 
"Critical", then the critical tasks and non-critical tasks in the project will be divided into two groups to 
display respectively. 

(3) Reduce the total project duration 

Suppose that the project needs to be completed 30 working days ahead of schedule due to various 
objective reasons, that is, the total project duration needs to be adjusted from 230 working days to 200 
working days. In this case, we need to compress the total duration of the project. Common ways to do 
this are rushing, parallelizing tasks, changing the task calendar, and so on. Note: The total duration of 
the project can only be reduced by compressing the critical path. 

3.3. Baseline setting 

The schedule baseline is the basis for measuring the schedule performance. The baseline is 
generally approved by the responsible department and recognized by the relevant stakeholders of the 
project, and does not change if necessary. If changes are necessary, they need to go through formal 
change procedures. The method of setting the progress baseline is very simple. First, open the Project 
software, click "Set Baseline" in the function group of "Daily Arrangement" in the "Project" menu, and 
click "OK" in the pop-up window. Secondly, the left view was switched from [Gantt chart] to [tracking 
Gantt chart]. Finally, observe the change in the Gantt chart area on the right.The gray bar shows the 
baseline set for progress. 

3.4. Update monitoring 

In the process of project execution, it is necessary to grasp the project progress in real time and 
adjust the plan dynamically, so it is necessary to set the appropriate update frequency according to the 
total duration of the project. In this case, the total duration of the project is 230 working days, so the 
update frequency can be set to be updated every 20 working days. The following is a brief introduction 
to the basic operation flow of updating the plan and monitoring the execution of the plan. 

(1) Set the status date 

The first step to update the project plan is to set the status date. Since the project calendar set in this 
case is a standard calendar, Saturday and Sunday are non-working days. With the project start time set 
to Wednesday, January 18, 2023, the status date for the first project update will be 20 working days 
later: February 15, 2023. Open the Project software, click "Status Date" in the "Status" function group 
of the "Project" menu, and set February 15, 2023 as the status date in the pop-up window. Click "OK". 

(2) Manually enter the actual status information of the project 

The current plan of the project can be reflected by the preset columns [start time] and [completion 
time]. The actual status of the project can be reflected by the preset columns [actual start time] and 
[actual completion time]. Do the following:  

Firstly, open the Project software and add the preset columns [actual start time] and [actual 
completion time] in the workspace.  

Secondly, when the deadline date (January 15, 2023) was manually entered, the actual start time 
and actual completion time of each task of the project were manually entered.  

Finally, observe the impact of input on the preset columns [Start time] and [Finish time] that reflect 
the current plan.  

Conclusion: After the [actual start time] and [actual completion time] of a task are entered, Project 
will automatically adjust the [start time] and [completion time] of the current plan of the subsequent 
task. 

(3) Compare the differences between the current plan and the baseline 

Open the Project software and add three preset columns [start time difference], [finish time 
difference] and [Duration difference] in the workspace. According to the formula:  

1) Start time difference = current scheduled start time - baseline start time;  
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2) Completion time difference = current planned completion time - baseline completion time;  

3) Project time difference = current planned project time - benchmark project time.  

It can be concluded that if the difference is >0, the progress is lagging behind. If the difference is <0, 
we are ahead of schedule. 

3.5. Evaluate and close 

In the Project, various reports can be made to record the execution of the project phase or the final 
results. Here to make a "custom task duration report" as an example to explain. First of all, open the 
Project software, click [New Report] in the [Report] menu [View Report] function group, then enter the 
customized report name in the [Report Name] form that pops up, and click [Confirm]. Then, click 
[Chart] in the [Insert] function group of the [Report Design] menu, then select the appropriate chart in 
the [All Charts] that pop up, and click [Confirm]. Finally, the [project task duration report] was made to 
visually display the difference between the planned duration and the baseline duration. 

4. Conclusions 

Firstly, combined with the improvement path of teachers 'digital competency, this paper put forward 
the importance of project management thinking training. Secondly, the concept and basic process of 
project schedule management are explained based on schedule management, which is one of the ten 
knowledge fields of project management. Finally, taking the "textbook writing project" as the target 
case to implement progress management, the process of project plan preparation, project plan 
optimization, project benchmark setting, project update monitoring and project evaluation completion 
are respectively explained. It is hoped that it can help teachers establish project management thinking 
and provide certain reference value for the establishment of future teachers 'digital competency training 
system. 
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